Chapter 3
Adding Elements to A Workbook

In this chapter you will learn how to add images, charts, formula and functions
and perform mathematical calculations. Charts help us to quickly understanding
the data by plotting the data in graphs. Formulas are used for simple addition,
subtraction, multiplication and division as well as for complex calculations. To
make a calculation, you must write a formula. Functions are built in formulas.

3.1 ADDING IMAGES

Follow these steps to add a picture, photo or graphic from an existing file:

Step 1: Click on Insert Tab

Step 2: From Illustrations Group, Click Picture

Step 3: Select a picture from the location of the picture (where you have stored
the picture) and press enter or click on insert button

Step 4: The picture is added on the excel sheet

Step 5: Click on the picture to activate Format tab

Step 6: Use appropriate options to make necessary changes in the picture
appearance
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3.2 MODIFYING IMAGE

When an image is selected, Excel adds the Picture Tools Format tab to the
Ribbon. Use the commands on the Picture Tools Format tab if you need to modify
images in your worksheets. The Picture Tools Format tab is divided into four
groups: Adjust, Picture Styles, Arrange, and Size. You can use options of Adjust
group to modify image brightness, contrast, color, and to compress it. To modify
orientation and style of images use the options of Picture Styles group. Click a
thumbnail on the Picture Styles gallery to select a new orientation and style for the
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selected image. You can also modify Border shape of a selected image by using
Picture Shape button’s drop-down list. To modify Border color you can use
Picture Border button’s drop-down color list and to add picture effects use Picture
Effects button’s drop-down list.

3.3 CHARTS

Charts allow you to present data entered into the worksheet in a visual format
using a variety of graph types. Numeric information is often easiest to understand
when it is presented graphically in an excel chart. In Excel, you can represent
numbers in a chart. The basic procedure for creating a chart is the same no matter
what type of chart you choose. As you change your data, your chart will
automatically update. To create a chart, you must first enter data into worksheets.
In this section you will learn to create simple charts from the data.

Element of a chart
A chart has many elements. By default some elements are visible, others can be

added as per requirement. You can also remove chart element that you do not
want to display.
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Chart Area: Is the entire area that is reserved for accommodating the
charts and other components such as titles, legends etc.
Plot Area: Is the part of chart area which contains the chart
Chart Title:A title is given to whole chart
Chart Axis Titles:
X-Axis Title - A title given to the X-axis data range.
Y-Axis Title - A title given to the Y-axis data range.

[l Legends: Are some sort of labels that identify different series that are
being plotted in a chart. These labels are attached to a symbol or
color or pattern, that is associated with series of chart.

[l Horizontal (X) and Vertical (Y) Axis

[l Data Labels:The values of the data series plotted.

[l Gridlines: Displays lines at the major intervals on the category (x) axis

and/or Y-axis
Excel chart wizard helps you to create charts in excel. You have to select data first
before launching the chart wizard. Following are the steps to launch chart wizard:
Step 1: Goto Charts group of Insert tab
Step 2: Select Chart sub-type

OO d —_

3.4 TYPES OF CHARTS

MS Excel 2007 supports many types of charts to help you display data in different
ways that are meaningful to your audience. You can create a new chart or can
change the existing chart, from the variety of chart types and their subtypes. You
can also create a combination chart using more than one chart type in your chart.

Column Charts

The Column Charts are very used to compare values across categories by using
vertical bars. In a Column Chart, the vertical axis (Y-axis) always displays
numeric values, and the horizontal axis (X-axis) displays time or other category.

Line Charts

Line charts can be used to display continuous data over time with respect to a
common scale. Thus Line Charts are best suitable for displaying data trends. The
horizontal (X) axis is used to represent time or other category data and the vertical
(YY) axis represents numeric values.

Pie charts
As name the implies, pie charts are shaped like a pie, and are useful in a situation
where one has to show the relative proportions or contributions to a whole. A Pie
Chart can only display one series of data.
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Bar Charts

A bar Chart is the horizontal version of a Column Chart, i.e., bar chart is like a
column chart lying on its side. Bar Charts do tend to display and compare a large
number of series better than the other chart types.

Area Charts

Area Charts are like Line Charts except that the area below the plot line is solid.
Like Line Charts, Area Charts are used primarily to show trends over time or
other category.

XY (Scatter) charts

The purpose of a Scatter Chart is to observe how the values of two series
compares over time or other category. The point of difference between XY charts
and other types of charts is that in XY charts both axes display values i.e. they
have no category axis. Such type of charts is generally used to show the
relationship among two variables.

Other charts types

Excel offers other chart types, but the average user will not use this type of charts.
Other available chart types in excel are: Stock, Surface, Doughnut, Bubble, and
Radar.

3.5 CHART TOOLS

Whenever you click on some component of chart, you observe that the Chart
Tools are displayed to the ribbon. Chart tools include three chart context tabs:
Design, Layout, and Format. These tabs are called context tab, as these tabs only
appear when you need them. These tabs become available when you create a new
chart or when you click on a chart. You can also use these tabs to modify your
chart. Design tab is used to modify the shape of chart. Layout tab, is used to add
all sorts of elements related to chart or change the way they are shown in the
chart. Format tab is used to apply special effects, such as the bevel effect etc.
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3.6 CREATING CHARTS

The basic procedure for creating a chart is the same no matter what type of chart
you choose. As you change the data, your chart will automatically change. On the
Insert tab, you can choose from the variety of chart types such as: line, pie, area,
column etc. Use following steps to draw a Chart:
Step 1: First enter the data in the work sheet of which you want to plot the chart
Step 2: Select all the cells containing the data you want in your chart
Step 3: Click Insert tab
Step 4: Select a Chart Type from the chart group and sub type of chart
Step 5: Select the Title of the chart

a. To give a title to a chart, click on the chart. Now you can see layout

tab available. Click on Layout tab

b. Choose(click) on chart title option available in the Label group
Step 6: Click on the chart title and write a title
Step 7: Similarly set other elements of chart

A B - D E F

1 Exam Scores

2 Ajay |Akhil | Anil | Atul
3 |Physics 53| 60| 55| 32
4 |Chemistry 55| 53| 58| 39
5 |Mathematics| 63 55| 61| 64
6
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3.7 MODIFYING CHARTS

You can use chart context tabs to modify your chart. These tabs become available
when you click on a chart. You can right click on an element of the chart for quick
access to specific features with respect to that particular element e.g. if you right
click on plot area, you will get Format Plot Area dialog box, similarly if you right
click on any chart axis, you will get Format Axis dialog box. Using these format
dialog boxes, you can modify your chart.

Modifying the chart Type

Excel provides many chart types to help you display data in a way that will best
communicate its meaning. Use following steps to modify the chart type:

Step 1: Click the chart

Step 2: Select chart type from chart tab

Step 3: Choose appropriate type from chart type dialog box

Step 4: Click ok

Modifying the chart area

The chart area is the background of the sheet on which the chart is drawn. Use

following steps to modify the chart area:

Step 1: Double click on chart area

Step 2: In the Format chart area dialog box, click the pattern tab and enter new
settings to changes the border surrounding the chart area, its color, and
any fill effects

Step 3: Click the Font tab and enter new settings to changes the font
characteristics of the axis labels
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Resizing the Chart

To resize the chart, click on its border and drag any of the eight black handles to
change the size. Handles on the corners will resize the chart proportionally while
handles along the lines will stretch the chart.

Delete a Chart
To delete a chart that has just been created, click the Excel Undo button. To delete
an existing chart, select the chart and press the Delete key.

3.8 MOVING CHARTS

To move a chart to a different place on the worksheet, select the chart and drag it
to the desired location. To move a chart to a new or different spreadsheet in the
same workbook, select the chart, right-click, and select Move Chart. Move Chart
dialog box will appear. Then choose the sheet or type in a new sheet name, and
click OK. Elements within the chart such as the title and labels may also be
moved within the chart. Click on the element which you want to move, and use
the mouse to drag the element to move it.

3.9 ORGANIZATIONAL CHARTS

An organizational chart graphically represents the management structure of an

organization, such as department managers and non-management employees

within a company. By using a SmartArt graphic in MS excel, you can create an

organizational chart and include it in your worksheet. To create an organizational

chart quickly and easily, you can type or paste text in your organizational chart

and then have the text automatically positioned and arranged for you. Use

following steps to create an organizational chart:

Step 1: Go to the Insert tab, in the Illustrations group, click SmartArt

Step 2: Click Hierarchy on the Choose a SmartArt Graphic window

Step 3: Select the chart design to use and click OK

Step 4: Click on the word Text in the first shape and type the name or title of the
corresponding employee. Repeat with the remaining shapes
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You can add more shapes by right-clicking a related shape and clicking Add
Shape. Choose Add Shape Before or Add Shape After to add another employee
on the same level as the selected one. Choose Add Shape Aboveto add an
employee one level up from the selected person or Add Shape Below to add
someone who reports to the selected employee. To delete a shape, click on the
border of the shape that you want to delete, and then press delete. Similarly, you
can also apply colors, change line styles etc, using different available options.

3.10 SPARK LINE

A sparkline is a very small line chart that is typically drawn without axes or
coordinates. Sparklines are small enough to be embedded in text or several
sparklines may be grouped together as elements of a small multiple. Data
presented in a row or column is useful, but patterns can be hard to spot at a glance.
The context for these numbers can be provided by inserting sparklines next to the
data.

Using following steps to create a sparkline:
Step 1: Select all the cells containing the data you want create sparkline for and
go to Insert tab then click the Charts group
Step 2: Click the Line option and select the 2D line chart
Step 3: Select the Legend and press delete key
Step 4: Select Horizontal Axis and Vertical Axis and press delete key
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Step 5: Select the horizontal grid lines and press delete key
Step 6: Select the chart and drag the handles to the desired size

1 Exam Scores

2 |Ajay Alkhil Anil Atul

3 33 60 55 52
4 55 53 58 59
5 63 35 61 64
6 66 70 68
7 80 69 78 51
8 56 75 65 79
3 76 20 59 73
10 79 52 60 66

—_—N

The sparkline in the above figure shows the scores that Ajay achieved in his tests.
By looking at this sparkline, you can quickly figure out how Ajay's scores are
going up and down along the time.

3.11 FORMULAS AND CALCULATIONS

DEFINITION AND EXPLANATION OF FORMULAS AND
CALCULATIONS

Excel performs calculations using formulas and functions. A formulais a
structured piece of text that tells Excel what it has to calculate. A function is a pre-
written formula. When there is some change in the data, such formulas
automatically calculate the updated results with no extra efforts on the part of the
user. In excel a formula always starts with the 'equal to' = sign. It a sign that tells
excel that what is in the cell is a formula and not a text or a number. 'Equal to' =
sign can be followed by numbers, mathematical operators (like a + for addition, /
for division, logical operator [<, >] etc) and build in excel functions. For example
in the below figure, cell B2 contains a formula that multiplies 3 by 4 and then
adds 7 to that result to come up with the answer 19.

=3*4+7
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Here are some more examples of formulas that you can enter in a worksheet.
0 =Al1+A2+A3+A4 Adds the values in cells A1, A2, A3, and A4.
0 =SUM(A1:A8) Uses the SUM function to return sum of the

values in A1 through AS8.

0 =AVERAGE(A1:A10) Uses the AVERAGE function to return average
of the values from A1 through A10.

0 =TODAY() Returns the current date.

After the formula is completely entered in the cell, it will display the result. Also,
when you select or click on a cell which is having some formula, the formula will
appear in the formula bar. If you want to change the formula, you can click on the
Formula bar to edit it. Alternatively, you can press the F2 key or double click the
cell for it. In Excel 2007, the formulas are available in the Formulas Tab. If you

click on the Formulas tab, you can see the corresponding ribbon display with
available formulas, as shown below.
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3.12 MATHEMATICAL OPERATORS

Mathematical operators play fundamental role to create a formula and calculation
of data values in the spreadsheet. Basically operators specify the type of
calculation that you want to perform on the elements of a formula, like addition,
subtraction, multiplication or division. There is a default order in which
calculations occur, but you can modify this default order of calculation as per your
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requirement using parentheses. To change the order of calculation, enclose in
parentheses the part of the formula to be calculated first. For example, the
following formula produces 12 because Excel calculates multiplication before
addition. This formula multiplies 2 by 3 and then adds 6 to the result.

=6+2*3

In contrast, if you use parentheses to change the syntax, Excel adds 6 and 2
together and then multiplies the result by 3 to produce 24.
=(6+2)*3

3.13 CREATEING A FORMULAS

To create a simple formula that adds two numbers use following steps:

Step 1: Click the cell where you want to insert the formula (A3, for example)
Step 2: Type the ‘equal to’ sign (=)

Step 3: Type the first number to be added (e.g., 20)

Step 4: Type the addition sign (+)

Step S: Type the second number to be added (e.g., 10)

Step 6: Press Enter to complete the formula
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For creating a simple formula that adds the contents of two cells: in previous
example type the cell addresses in place of first and second numbers.
Alternatively, in place of typing the cell addresses yourself in the formula, you
can click on the cell to be included in the formula.

3.14 CREATING FUNCTIONS

A predefined formula is called a function, which uses a specific value in a
particular order to execute calculation. Functions enable you to add thousands of
numbers together in an instant, calculate averages and many other things. All
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functions have a function name. For example, the function that adds together
numbers is called ‘SUM’ and the function that calculates averages is called
‘AVERAGE’. Function name is followed by one or more arguments, which may
be numbers or cell references. If there are more than one arguments in function,
they are separated by semicolon ’;’. Each function has a specific order, known as
syntax that strictly followed for the function to work correctly. Following figure
shows an example of ‘AVERAGE’ function with one argument i.e. the range of
cells, A3 to C3.
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3.15 REFERENCES

References are an important part of creating formulas in Excel. Cell references
allows your formulas to update automatically if the value in a particular cell
changes and can also assist you in updating formulas as cells are copied or moved.
There are two types of cell references: relative and absolute. Relative and absolute
references behave differently when copied and filled to other cells. Relative
references change when a formula is copied to another cell. Absolute references,
on the other hand, remain constant no matter where they are copied.

By default, a cell reference is relative, e.g., =Al. By adding a dollar sign
($) before either the column or row location or both, that reference becomes
absolute. When adding dollar signs to cell references, only the portion of the
reference directly following the dollar sign is absolute. To keep the entire cell
reference constant, place a dollar sign before both the column and row location.
e.g., =$AS$1. Relative and absolute cell references can be used in all situations that
require cell references, including cell ranges and formulas.
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You can also create mixed references, in such references the column is absolute
and the row is relative or vice versa. To create a mixed reference, you use the
dollar sign in front of just the column letter or row number, e.g., =$A1.

COPYING A FORMULA

Excel makes it easy to copy your formula across an entire row or column, but you
don't always get the results you want. To copy a formula into multiple cells by
dragging, use following steps:

Step 1: Enter the formula into one cell

Step 2: Press enter to calculate the formula

Step 3: Click on the lower right corner of the cell to be propagated

Step 4: Hold and drag along the column or row you're copying to

Step 5: Double click the plus sign to fill the entire column
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3.16 EXCEL FORMS

If your spreadsheet is too big to manage, and you constantly have to scroll back

and forward just to enter data, then a Data Form could be very helpful. A data

form provides a convenient means to enter or display one complete row of

information in a range or table without scrolling horizontally. The data form

displays all the columns so that you can see all the data for a row at one time. To

create a data form use following steps:

Step 1: You must add labels to the top of each column in the range or table, since
excel uses these labels to create fields on the form

Step 2: Select a cell in the range or table to which you want to add the form

Step 3: Click Form button on the Quick Access Toolbar

If Form button is not available on Quick Access Toolbar, then you can add it as

follows:

Step 1: Click on Customize Quick Access Toolbar and select More Commands
from menu

Step 2: Choose All Commands from Choose commands from drop down list,
and then select Form in the below list,

Step 3: Click Add>>, and then click ok (Form button will be added to Quick
Access Toolbar)
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To start a new row in your spreadsheet, you just click the New button on the right.
Click Find Prev or Find Next,or Press [Up Arrow or Down Arrow] to move to
the desired row that you want to change or delete.

3.17 TABLES

In excel, basically everything is table except the diagram. Here by excel table we
mean a defined region in the spreadsheet with a group of data. Excel Tables are
used to analyze and manage a group of related data easily and quickly. It contains
related data in a series of worksheet rows and columns that have been formatted
as a table. The purpose of an Excel table is not so much to calculate new values
but rather to store lots of information in a consistent manner, making it easier to
format, sort, and filter worksheet data.

3.18 CREATING A TABLE

Use following steps to create a table:

Step 1: Select the range of cells you want included in the table (cells can be empty
or can contain data)

Step 2: Click Table in Tables group of Insert tab

Step 3: If the top row of the selected range contains data you want to use as table
headers, check the My table has headers box

Step 4: Click ok
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If you don’t check the My table has headers box, table headers with default
names like Columnl and Column?2 are added to your table above its data. You can
modify default header names at any time.

3.19 INSERTING ROWS AND COLUMNS INTO A TABLE

You can insert rows above a selected row and columns to the left of a selected
column. You can also delete rows, and columns. For inserting rows and columns
into a table use following steps:

Inserting Rows

Step 1: Select a row in table above which you want to insert a new row
Step 2: Right click on table row and select Insert from pop up

Step 3: Select Table Rows Above

Alternatively, select row and click Insert in the Cells group of Home tab and
choose appropriate option from popup menu. If you select the bottom row of the
table, then you will have one more option i.e. Table Rows Below to insert a row
below the bottom row.

Inserting Columns

Step 1: Select a column in the table left of which you want to insert a new column
Step 2: Right click on table column and select Insert from pop up

Step 3: Select Table Columns to the Left
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Alternatively, select column and click Insert in the Cells group of Home tab and
choose appropriate option from popup menu. If you select the last column of the
table, then you will have one more option i.e. Table Columns to the Right to
insert a column right to the last column.

3.20 DATA VALIDATION

Through data validation you can restrict the type of data or the values that users

enter into a cell. For example, we can use data validation to ensure that the user

chooses one of the few given options, by creating a drop-down list. This kind of

data validation allows you to build a powerful, fool-proof spreadsheet. Since users

won't have to type in data manually, the spreadsheet will be faster to use, and

there's a much lower chance that someone can introduce an error. Use following

steps to add data validation to a cell or a range:

Step 1: Select one or more cells to validate

Step 2: Click Data Validation in the Data Tools group of Data tab

Step 3: On the Settings tab of Data Validation dialog box, select appropriate data
validation type from Allow drop-down list

Step 4: Set parameters appropriately, as per your desired validation

Step 5: Use Ignore blank check box, to handle blank (null) values

Step 6: On the Input Message tab, choose whether to have Excel display an input
message when the cell is selected

Step 7: On the Error Alert tab, choose whether to have Excel display an error
alert after the user enters invalid data in the cell
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For example, to make sure user can enter marks between 0 and 20 only, the data
validation can be applied as steps shown in following figures.
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To remove data validation: select the cell or cells that contain the validation you
want to delete, then go to Data tab and click Data Validation in Data Tools
group then click ClearAll button in Data Validation dialog, and press ok.

3.21 FINDING INVALID ENTRIES AND AUDITING

You may want to audit your worksheets to look for invalid data entries that
may cause inaccurate calculations or results. You can identify cells with data
validation that contain invalid data by displaying a red circle around them so
that you can easily find and correct any problems.

To circle invalid entries: On the Data tab, in the Data Tools group,
click Data Validation, and then click Circle Invalid Data. All cells that don't
meet their data validation criteria are circled. Excel displays a red circle
around any cells that contain invalid data.

To hide wvalidation circles: Either enter valid data in the cell or on
the Data tab, in the Data Tools group, click Data Validation, and then
click Clear Validation Circles.

3.22 PAGE MARGINS

In Excel, page margins are used to specify how much blank space should be left

around the information in your worksheet. Margins are used to provide a visual

border for your printed page and an area where the page can be held or bound.

There are four margins you can specify: top, bottom, left, and right. Each margin

refers to the distance from the edge of the paper to where the information in your

worksheet can be printed. Thus, a one-inch top margin means there will be one

inch of white space at the top of each page of your printout. There are three

predefined margin settings. You can choose from them or you can also customize

the margins as follow:

Step 1: Go to Margins option from Page Setup group of Page Layout tab

Step 2: Click Margins and select Custom Margins

Step 3: Set the page margins as required

Step 4: Enter values in the header and footer fields to indicate how far from the
edge of the page header and footer should appear

Step 5: Check the boxes for centering horizontally or vertically on the page
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3.23 PAGE ORIENTATION

Excel offers two page orientation options: landscape and portrait. Landscape
orients the page horizontally, while portrait orients the page vertically. Portrait is
especially helpful for worksheets with a lot of rows, while landscape is best for
worksheets with a lot of columns. By default, Excel prints worksheets in portrait
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orientation. You can change the page orientation to landscape on a worksheet-by-
worksheet basis. To change page orientation use following steps:

Step 1: Click Orientation in Page Setup group of Page Layout tab

Step 2: Choose either Portrait or Landscape from the drop-down menu

i
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3.24 PAGE BREAKS

Page breaks are dividers that break a worksheet into separate pages for printing.
Excel inserts automatic page breaks based on the paper size, margin settings, scale
options, and the positions of any manual page breaks that you insert. To print a
worksheet with the exact number of pages that you want, you can adjust the page
breaks in the worksheet before you print it. To set page breaks, select the row you
want to appear just below the page break by clicking the row’s label. Then choose
Page LayoutPage Setup GroupBreaksInsert Page Break . Excel will start
a new page from the selected row. Once you have inserted the page breaks you
can remove them by choosing the Remove Page Breaks option. By choosing
Reset All Page Breaks option, it will reset your page to the way you saved it last.
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3.25 SHARING WORKSHEETS AND WORKBOOKS

If you share a workbook, you can work with other people on the same workbook
at the same time. The workbook should be saved to a network location where
other people can open it. As the owner of the shared workbook, you can manage it
by controlling user access to the shared workbook and resolving conflicting
changes. You can keep track of the changes other people make and accept or
reject those changes. When all changes have been incorporated, you can stop
sharing the workbook.

The way that you choose to share data depends on many factors, including how
you want others to view or work with the data. For example, do you want to keep
sensitive or important information from being modified, or do you want to allow
users to change and edit the data? Use following steps for sharing workbook:
Step 1: Click Share Workbook, in the Changes group of the Review tab
Step 2: In the Share Workbook dialog box, on the Editing tab, check the box
which says Allow changes by more than one user at the same time.
This also allows workbook merging
Step 3: On the Advanced tab, select the desired options you want to use for
tracking and updating changes, and then click ok
Step 4: Do one of the following:
0 If this is a new workbook, type a name in the File name box
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0 Ifthis is an existing workbook, click OK to save the workbook
Step 5: If the workbook contains links to other workbooks or documents, verify
the links and update any links that are broken
Step 6: Click the Office button and then click Save
Or use keyboard shortcut, Press CTRLAS to save the workbook
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3.26 IMPORTING AND EXPORTING DATA

Although you can copy and paste data from and to Excel, like you can in almost
every other program. Excel lets you take this one step further using its Import and
Export features. These features are useful when you have to share data with
programs that don't work directly with Excel. In this section you will learn how
to import or export text files. There are two commonly used text file formats:

[
[

Delimited text files (.txt), in which the TAB character typically separates
each field of text

Comma separated values text files (.csv), in which the comma character (,)
typically separates each field of text

There are two ways to import data from a text file by using Excel: You can open

the text file in Excel, or you can import the text file as an external data range. To

export data from Excel to a text file, use the Save As command. In the following
given steps, we assume that in the text file, TAB character separates each field of
text. To import a text file (in which the TAB character typically separates each
field of text by opening it in Excel, use following steps:

Step 1: On the Office button, click Open

Step 2: Select Text Files from the Open dialog box then Locate and double-click

the text file that you want to open

Step 3a: To import a .csv file, select the .csv file and click Open, That's all
Step 3b: To import a .txt file, select the .txt file and click Open, Excel launches

the Text Import Wizard

Step 4: Choose Delimited and click Next
Step S: Clear all the check boxes under Delimiters except for the Tab check box

and click Next

Step 6:Click Finish.
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To import a text file by connecting to it, use following steps:
Step 1: Click the cell where you want to put the data from the text file
Step 2: On the Data tab, in the Get External Data group, click From Text
Step 3: Locate and double-click the text file that you want to import, Excel
launches the Text Import Wizard
Step 4: Choose Delimited and click Next
Step 5: Clear all the check boxes under Delimiters except for the Tab check box
and click Next
Step 6: Click Finish, the Import Data dialog box will appear
Step 7: In the Import Data dialog box, do the following:
[l Optionally, click Properties to set refresh, formatting, and layout options
for the imported data
[l Under Where do you want to put the data?, do one of the following:
1) To return the data to the location that you selected, click Existing
worksheet
2) To return the data to the upper-left corner of a new worksheet,
click New worksheet
Step 8: Click OK
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To export text files, use following steps:

Step 1: Open an Excel file

Step 2: On the Office button, click Save As

Step 3: Select Text (Tab delimited) or CSV (Comma delimited) from the drop-

down list

Step 4: Click Save

Important Points:

O O o o o o o 0o o o o &4

Charts allow you to present data entered into the worksheet in a visual
format using a variety of graph types.

Legends are some sort of labels that identify different series that are being
plotted in a chart.

Pie charts are useful in a situation where one has to show the relative
proportions or contributions to a whole.

Column Charts are used to compare values across categories by using
vertical bars.

The purpose of a Scatter Chart is to observe how the values of two series
compares over time or other category.

To display the formatting dialog box appropriate for a chart element,
double click on it.

To move a chart to a different place on the worksheet, select the chart and
drag it to the desired location.

By using a SmartArt graphic in Excel, you can create an organization chart
and include it in your worksheet.

A sparkline is a very small line chart that is typically drawn without axes
or coordinates.

A formula is a structured piece of text that tells Excel what it has to
calculate.

A predefined formula is called a function, which uses a specific value in a
particular order to execute calculation.

The purpose of an Excel table is to store lots of information in a consistent
manner, making it easier to format, sort, and filter worksheet data.

Practice Questions

Objective type questions:
Q1.In order to edit a chart, you can

a.

b.

Click the chart object
Click and drag the chart object
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c. Double click the chart object
d. None of above

Q2. Each excel file
a. can contain text and data
can be modified

b.
c. can contain many sheets including worksheets and chart sheets
d. All of above

Q3. What do you use to create a chart?
a. Pie Wizard
b. Excel Wizard
c. Data Wizard
d. Chart Wizard

Q4.To insert a picture in Excel, use Picture option from
a. Illustrations Group
b. Arrange Group
c. Connections Group
d. Text Group

Q5. Which of the following is an absolute cell reference?

a. 1A!l
b. $AS1
c. #Ha#l
d. Al

Q6. Which of the following options cannot be set in the page setup dialog box?
Printer selection

Vertical or horizontal placement

Orientation

Row and column titles

eao o

Very short answer type questions:

Q1. Excel chart wizard is used for?

Q2. Which Charts are best suitable for displaying data trends?
Q3. What is Legend?

Q4. Pie chart is useful in?

QS.Define sparkline.
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Short answer type questions:

Q1. What is importance of chart?

Q2. Explain the type of charts in Excel.

Q3.What are chart tools?

Q4. Write different ways to modify charts.

Q5. How cell reference is useful in the calculation?
Q6. What is function in Excel?

Q7. Explain table insertion in Excel.

Q8. What is data validation?

Essay type questions:

Q1. How you can create charts using Excel? Explain steps.

Q2. What is the use of chart? Explain the element of a chart.
Q3.Explain the organizational charts.

Q4. Explain functions in Excel.

QS. Explain references in Excel.

Q6. What is Excel form? How you can create a data form in excel?
Q7. Write down the steps to add data validation to a cell or a range.
Q8. How you can share your worksheets and workbooks in Excel?
Q9. How you can import and export data in Excel?

Q10. What is sparkline? Write down the steps to create a sparkline.

Answers key for objective questions

Ql:
Q2:
Q3:

Qs:
Q6:

O o ® oo
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